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CONFIDENTIALITY STATEMENT AND DISCLAIMER This document embodies CONFIDENTIAL and PROPRIETARY design information
originated by KAYDON CORPORATION (hereinafter “Kaydon™). All design, manufacturing, reproduction, use, and sale rights regarding this
document are expressly reserved by Kaydon. This document is submitted under a confidential relationship for a specific purpose, and the recipient
agrees by accepting this document not to supply or disclose any information regarding it to any unauthorized person, or organization, or to
incorporate in any other projects any special features peculiar to the design illustrated in this document without the express written consent of
Kaydon. All patent rights to the design illustrated in this document are expressly reserved by KAYDON. All copyrights in this document are
expressly reserved by KAYDON. This document is protected under the copyright laws of the United States as an unpublished work. Possession of
this document confers no rights to use the information contained thereon for manufacturing purposes, and KAYDON MAKES NO WARRANTY
THAT SUCH INFORMATION IS COMPLETE OR THAT ANYTHING PRESENTED IS FIT FOR ANY PARTICULAR PURPOSE.

1.0 PURPOSE

This document explains how to use the CS/Sales Exceptions Notifications Form Letter.

2.0 REFERENCES

CSF 70-42-006 CS/Sales Exceptions Notification Form Letter

3.0 DEFINITIONS AND ACRONYMS

CS Customer Support

ENFL Exceptions Notification Form Letter

Macro Recorded commands in MS Word which are then accessed through a single simple
step., command, or click on a toolbar command

Plants and Sales Special toolbar provided in the document CSF 70-01-001.dot, for accessing macros to

Reps Toolbar complete the RMA Validation form

4.0 RESPONSIBILITIES

All Sales/CS Representatives are to follow these instructions when completing the Exceptions Notifications
Form letter.

5.0 ABOUT THE EXCEPTIONS NOTIFICATIONS FORM LETTER (ENFL)

The ENFL is a Word template and saved as a .DOT file. It is used to create exceptions letters for customers,
and includes macros that let you quickly enter the desired information in the letter.

5.1 Open the Exceptions Notifications Form Letter
1. Open MS Word.

2. On the File menu, select New.
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The New Document task pane appears to the right of Word (Figure 1).
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Figure 1. Opening a New Document Based on a Different Document

3. Under the New section, click From existing document... (Figure 1).
The "New from existing document” dialog box appears (not shown).

4. Navigate to:
\\bear-plt01-srvl\shared\Intranet\Sales\Public\SalesTemplates\ and select Exceptions_CSF_70-42-006.dot.

e A new document appears in Word (1 in Figure 2).

e There are fields for clicking and entering data (2 in Figure 2). Unneeded lines with these fields
can be deleted.

e A new Text and Sales Representatives toolbar appears (3 in Figure 2).
e There are drop-down fields from which you can choose the correct text (4 in Figure 2).
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Date: 2 August 26, 2008
To: <Click and Enter Customer Name=
Address: =Click and Enter Customer Address=>

Text and Sales Representatives
Sales Reps = | Closing Paragraph = Edit Template ~

RFQ #: =Click and Enter RFQ Number=
Quote or PO #:  =Click and Enter Quote or PO Number=
Customer Drawing #: <Click and Enter Customer Drawing Number=
Kaydon Drawing #: =Click and Enter Kaydon Drawing Number=

- Attached is our [Belect quote or order__.[!hd a drawing review made by Kaydon regarding your
. part number. Oy  select quote or order. .. s areas of discrepancy between drawings (see

- attached docum  price quote 4 Epancies]. Please have your Engineering Department
+ review the indici  confirming order O ment any changes need to resolve them.

Kaydon actively tracks drawing discrepancies. Our Quality Department can delay shipment
because of them. Consequently, it is important that the discrepancies be resolved as soon as
possible.

The discrepancies can be resolved by doing one of the following:

1. Formally change the drawing supplied to Kaydon. This option is preferred as the solution
will be permanent (preferred, as results in permanent change in your files).

2. You can accept the stated discrepancies with no change to the design. In this case, the
solution is temporary and will apply to i
Select an option

= <Select the correct closing Representatives toolbar=

] this order only
Thank you in advance fory  this quote and subsequent order only

oo

=smE]=w<¢
Page 1 Sec 2 11 At 5.27 Ln 27 Col 41

Sincerely,
|

|

Figure 2. Initial Appearance of the Exceptions Notification Form Letter
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Text and Sales Representatives v Text and Sales Representatives v
Sales Reps * || Closing Paragraph = Edit Template = Sales Reps * | |Closing Paragraph = | Edit Template =
Bill Coe Orders: Hard Exceptions
Bob Fonger Orders: Soft Exceptions
Carrie Blackmon Quotes: Any Exceptions
Cathy Tjapkes |- Delete and Select a Different Closing
Dave Kahler
Doug Poling
Elly Ward If you selected the wrong option, do not move
S the cursor or manually delete the text. Just click
the relevant Delete option (orange arrows).
Jack Adkins
Jane Grinnel The text is deleted and you can select a
Joe Vossekul different option.
Kurt Schlager
Lori Kuzma

Marda Walsh

Mike Lenkiewicz

Ron Shaw

Delete Mame

Figure 3. Text and Sales Representatives Toolbar

5.2 Enter Text in the ENFL

The easiest way to enter text is to simply click in the desired field and either enter the desired information, or
select the required option. Since only parts of the form are protected, pressing <Tab> does not jump to the
next field.

Enter data as follows:
1. Date: Click the date and Press <Ctrl + Shift + F9> to make the date permanent.
If you do not do this, the date will change to the current date, every time you reopen the file.
2. To: Click in the field and enter the customer's name
3. Address: Click in the field and enter the customer's address.
4. RFQ#: Click in the field and enter the RFQ number.
If you do not need this information, select the row and delete it.

5. Quote or PO#: Click in the field and enter the quote or PO# from Syteline.
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6. Customer Drawing #: Click in the field and enter the customer drawing number.
7. Kaydon Drawing #: Click in the field and enter Kaydon's drawing number.
8. Select Quote or Order: This is a text options drop-down box.

e Select price quote if this is relating to a price quote for the customer.

e Select confirming order if this is a confirmation of a customer order.
9. Select an option: This is a text options drop-down box.

e Select this order only if the issue relates only to the current order.

e Select this quote and subsequent order only if the issue relates to the quote being submitted
and the order resulting from this quote.

10. Select the correct closing paragraph from the Text and Sales Representatives toolbar: Select the
desired option from the Text and Sales Representatives toolbar. Text entered is as shown in Table 1.

11. Select your name from the Text and Sales Representatives toolbar: Select your name as shown in
Figure 3.

Table 1. Text Options and Resulting Text

Closing Paragraph Option Resulting Text

Orders: Hard Exceptions If we do not receive a written response from you within 10 days of
receipt of this letter, your order will be placed on hold until the
discrepancies are resolved.

Orders: Soft Exceptions If we do not receive a written response from you within 10 days of
receipt of this letter, we will process your order according to our
Kaydon drawing specifications. We must hear from you if you want
the discrepancies to be resolved before filling your order. Thank you in
advance for your attention to this matter.

Quotes: Any Exceptions If you decide to accept the discrepancies, please be sure to indicate this
in writing on any purchase order issued based on this quote.

5.3 Finishing the ENFL

Be sure to attach a copy of the specifications drawing and a separate list of discrepancies with the letter,
before sending it by fax or email to the customer.

6.0 EDITING THE DEFAULT TEXT OR SALES REPRESENTATIVE
INFORMATION

You must use the Microsoft Visual Basic editor to edit the names of Sales Representatives, or add a new
name. Certain text is entered via Form Fields; other text is entered as an auto text entry. Read these
instructions carefully before updating the default list of names or text.
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6.1 Open the ENFL for Editing Default Options
< In MS Word, open the document Exceptions_CSF_70-42-006.dot.

¢ The document is located in the SalesTemplates directory on the Intranet.

¢ Make sure the document attributes are not set to Read Only. If the attributes are set to this
value, change them.

6.2 Change Control of the ENFL

After you have changed and tested the template, give it to the CS Manager or designee for approval and
storing on the network, for permanent storage of the template with all previous versions.

6.3 Update a Name
1. Open the source template as detailed in Section 6.1.

2. The Visual Basic Editor appears.

e Make sure that you are looking at the macros for Exceptions_CSF_70-42-006.dot (yellow
highlight in Figure 4).

e The macros are edited in the right panel (pink areas in Figure 4).

e The phrase "Sub" indicates the beginning of a macro.
e The phrase "End Sub" indicates the end of a macro.

@ Microsoft Visual Basic - Exceptions_CSF_70-42-006 - [NewMacros (Code)]
% File Edit WView Insert Format Debug Run  Tools  Add-Ins  Window Help Type a guestion for help = o &

1 R N REEWEC: N u @ b & F @ B

| p

Project - TemplateProject % |tGeneraI] j |DaveKahIer j
0 | ! End Sub zI
- ETemplateProiect (Exceptions_CSF_70-42-006) » Sub RonShaw ()

-3 Microsoft Word Objects ] '
ThisDov:ument ' BonShaw Macro

[=1-E5 Modules i ' Macro written 6/16/08 by DHemstreet
Selection.TypeText Text:="Eon Shaw"
Selection.TypeParagraph

Selection.TypeText Text:="5ales Representative"
|Mewl-‘lacm5 Module Selection.TypeParagraph
Alphabetic ICategorized Selection.TypeText Text:="Phone: +(440) 871-2500 ext. 22"
P — Selection.TypeParagraph =
Selection.TypeText Text:="Fax: +(440) E71-2503"
End Sub

== | i

Figure 4. Visual Basic Editor for Macros in CSF_70-01-001

3. Scroll through the macros to find the one you want to edit. For this example, locate the macro called
"RonShaw".
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a. Ron has a new job title. Note the text "Sales Representative™ in Figure 4. Replace all text
between the quotation marks with the new job title.

b. Ron has a new phone extension. Note the text ext. 226". Simply write the new number in and
delete the 283.

c. Edit the rest of Ron's information as needed.

d. For best practices, change the line 3 of the macro from "Macro written 6/16/08 by Dhemstreet"
to "Macro edited date by your name" (Example: Macro edited 8/29/08 by TJones)

Press <Ctrl+S> to save your changes.
Close the Visual Basic window by clicking the red and white X at the top right of the window.
Save and close Exceptions_CSF_70-42-006.dot

You can now see Exceptions_CSF_70-42-006.dot.

© N o 0 &

Change the file attributes to Read Only (to prevent accidental permanent changes to the template).

6.4 Create a New Name
1. Open the source template as detailed in Section 6.1.

2. In MS Word, open the document Exceptions_CSF_70-42-006.dot.

e The document is located in the SalesTemplates directory on the Intranet.

e Make sure the document attributes are not set to Read Only. If the attributes are set to this value,
change them.

3. Onthe " Text and Sales Representatives"” toolbar click "Edit Template™ and select Edit
Addresses/Sales Reps.

4. The Visual Basic Editor appears.

e Make sure that you are looking at the macros for Exceptions_CSF_70-42-006.dot (yellow
highlight in Figure 4).

e The macros are edited in the right panel (pink areas in Figure 4).
e The phrase "Sub" indicates the beginning of a macro.
e The phrase "End Sub” indicates the end of a macro.

5. Copy the text from "Sub" through to "End Sub" for one of the macros. In this example you will
create a new sales representative name based on the "RonShaw" macro.

a. Scroll to the end of the macros and place your cursor at the end of the last "End Sub” statement.
b. Press <Enter>.

c. Paste the copied text.

Sample_Employee_Work_Instructions_for_Custom_Form.doc CONFIDENTIAL NOT CONTROLLED IF PRINTED



NUMBER REV.

STANDARD WORK INSTRUCTIONS SWI 70-22-013 A
® How to Use the Exceptions Notifications Form Letter =~ REPLACES
BEARINGS DIVISION None
PAGE
8 of 13

You are now looking at text as shown in Table 2.
d. Change the text to appear as shown in the "Revised Macro" column in Table 2.

Revised text is in bold and red.
Table 2. Editing a Macro in CSF_70-01-001.dot

Original Macro Revised Macro

Sub RonShaw Sub JohnDoe()

' RonShaw Macro "JohnDoe Macro

' Macro recorded 3/19/2008 by DHemstreet " Macro edited 3/30/2008 YourName
Selection.TypeText Text:="Ron Shaw" Selection.TypeText Text:="John Doe"
Selection.TypeParagraph Selection.TypeParagraph
Selection. TypeText Text:=" Sales Representative" Selection.TypeText Text:="Sales Administrator"”
Selection.TypeParagraph Selection.TypeParagraph
Selection.TypeText Text:="Phone: +(231) 755-3741 ext. 226" Selection.TypeText Text:="Phone: +(231) 755-3741 ext. 211"
Selection.TypeParagraph Selection.TypeParagraph
Selection.TypeText Text:="Fax: +(231) 755-7065" Selection.TypeText Text:="Fax: +(231) 755-70XX"

End Sub End Sub

6. Press <Ctrl+S> to save your changes.
7. Close the Visual Basic window by clicking the red and white X at the top right of the window.
You can now see Exceptions_CSF_70-42-006.dot.

8. Click anywhere on any toolbar. A drop-down list of available toolbars appears. At the bottom of the
list is the option, "Customize™. Click Customize.

The Customize dialog box appears.
9. Proceed as follows:

a. Click the Toolbars tab and make sure that the Text and Sales Representatives toolbar is
displayed.

b. Click the Commands Tab.
i. Inthe Categories area, select Macros.
ii. Inthe Save In drop-down box, select the document name (Exceptions_ CSF_70-42-006.dot).

iii. In the Commands area, scroll to the "JohnDoe™ macro (left, Figure 5). (All macros receive a
prefix "Project.NewMacros. XX X" where XXX is the name you are looking for).

c. Inthe Commands area, drag and drop the macro to the desired place on the Sales Reps menu of
the Text and Sales Representatives toolbar. Note that the full macro name appears.

I. Right-click the macro name on the drop-down men (right, Figure 5).

ii. In the drop-down list that appears, go into the Name field and change the name to "John

Doe".
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10. Click outside of the menu and Close the Customize dialog box.
11. Save and close Exceptions_CSF_70-42-006.dot

12. Change the file attributes to Read Only (to prevent accidental permanent changes to the template).

. Text and Sales Representatives v X
Customize
Sales Reps ~ || Closing Paragraph = Edit Template ~
Toolbars | Commands | Options Eill Coe
To add a command to & toolbar: select a category and drag the Text and Sales Representatives v X Bob Fonger
command out of this dialog box to a toolbar, R N
Sales Reps ~ || Closing Paragraph » Edit Template = -
Categories: Commands: Carrie Blackmon
- Bill Coe )
Mail Merge #| | fa TemplateProject.NewMacros.Ida # Cathy Tjapkes
Forms ) Bob Fonger
Control Toolbox ,533, TemplateProject.NewMacros. Jac JE e Dave Kahler
All Commands =
& TemplateProject.NewMacros. Jar Carrie Blackmon Doug Poling
;EITI.EFEXT: ,533, TemplateProject.NewMacros. Joe Cathy Tjapkes Elly Ward
i Wi Dave Kahl
St;_c'le_s |,53¢, TemplateProJect.NeAMacros.Jof} ave er Ida Jackson
Built-in Menus .
New Menu v | | &% |TemplateProject.NewMacros.Kur v Doug Paling Jack Adki
| = | 3 ns
Description: Elly Ward Jane Grinnel
Macro recorded 5/15/2008 by DHemsireet — | ane rinne
0 T Joe Vossekuil
Jack Adkins TemplateProject.NewMacros. JohnDoe -_‘
Reset
Jane Grinnell =
Save in: | Exceptions_CSF_70-42-006 | Keyboard.. _] [ Close ] Kurt Schlager [:%ele
Joe Vossekuil p——
’ [% [ Name: | RIS
e Marcia Walsh I = | |
| Copy Button Image
e Mike Lenkiewicz e
Marda Walsh . -
Ron Shauw Reset Button Image
Mike Lenkiewicz
Delete Name Edit Button Image. ..
Ron Shaw
Change Button Image »
Delete Name

Default Style

Text Only (Always)

Text Only (in Menus)
Image and Text

Begin & Group

Assign Hyperlink 3

Figure 5. Customizing the Toolbar and Options

6.5 Edit the Drop-Down Text Fields
1. Open the source template as detailed in Section 6.1.
2. Right-click anywhere on a toolbar and open the Forms toolbar (Figure 6).
3. Double-click the form-field to be opened (either "Select quote or order..” or "Select an Option").

The Drop-Down Form Field dialog box appears (Figure 7).
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AutoText
Control Toolbaox

Database

ab| ¥ B | 5 | o [ E (g

Drawing

E-mail ’ Pratect Form
Forms h |

]

Frames
Mail Merge
Qutlining

Picture

%WJW

Figure 6. Unprotecting a Form

Drop-Down Form Field Options

Drop-down item: Items in drop-down list:
|NE'.|‘-.' Optiu:un|

Select quote or order...

price gquote E]

[+

Run macro on

Entry: Exit:

| ¥ | vl
Field settings

Bookmark: |OrderTy|:uE |

Drop-down enabled

[] calculate on exit

[ Add Help Text... ] [ QK ][ Cancel

Figure 7. Adding/Editing Drop-Down Form Field Options
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4. To edit an option, proceed as follows:
a. Inthe Items in drop-down list panel, select the option to be edited.
b. Click Remove.
The option appears in the Drop-down item field.
c. Edit the option and click Add.
The revised option appears in the "Items in drop-down list" area.
d. Use the arrows to move the option up or down in the list.
e. Click ok when done.
5. To add a new option, proceed as follows:
a. Inthe Drop-down item field, enter the new option.
b. Click Add.
The new option appears in the "ltems in drop-down list" area.
c. Use the arrows to move the option up or down in the list.
d. Click ok when done.
6. Save and close Exceptions_CSF_70-42-006.dot

7. Change the file attributes to Read Only (to prevent accidental permanent changes to the template).

6.6 Edit/Add Closing Paragraph Text
The closing paragraphs have been entered as AutoText entries in this template. Editing or adding AutoText
entries involves the following main steps:
e Writing the AutoText entry.
e Creating an AutoText entry
e Copying the AutoText entry from the Normal.dot template to Exceptions_CSF_70-42-006.dot.
e Adding the AutoText entry to the Text and Sales Representatives toolbar (new entries only).

1. Open the source template as detailed in Section 6.1.

2. Go to the end of the document and write the new text, exactly as you want it to appear (see Figure
8).

3. Select the text, including the paragraph mark, and press <Alt+F3> (Figure 8).

e The Create AutoText dialog box appears.

e The first few words of your text are assigned as the name of the entry.
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4. Rename the AutoText entry and then click OK.

The AutoText Entry is saved in normal.dot template on your computer.

Create AutoText E|
2 Here-isa-sample-Auto Text-ertry that-includes-bold -

Word will create an AutoText entry
from the current selection.

.
( 3 l w “ito Text-entry that-includes-bold-and-italic. Please name your AutoText entry:
|

.
and <Alt+F3>.

[ Ok, ] [ Cancel

Figure 8. Creating/Editing an AutoText Entry

5. Save the AutoText entry to the Exceptions_CSF_70-42-006.dot template as follows:
a. On the Tools menu, click Templates and Add-ins.
The Templates and Add-ins dialog box appears (not shown).
b. At the bottom left of the Templates and Add-ins dialog box, click Organizer.
The Organizer dialog box appears (Figure 9).
c. Inthe Organizer dialog box, click the AutoText tab.
d. Verify that the correct templates are opened in the Organizer (yellow in Figure 9).

If not, click Close File. The button changes to Open File. Click Open File, navigate to the desired
template and then click Open.

e. Select the desired AutoText entry in Normal.dot.
f. Click Copy.
The AutoText entry is copied to the desired template.
6. Close the Organizer.
7. Save and close Exceptions_CSF_70-42-006.dot

8. Change the file attributes to Read Only (to prevent accidental permanent changes to the template).
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Organizer

Styles | AutoText | Toolbars " Macro Project [tems |

To CSF_70-42-006. dot: In Mormal.dot:

May be subject FieldForPEForm ~
Mot subject Filename B
OrdersHard Filename and path

Orderssoft Meesasame

gu;_testcégse In regards to:
ubjec

In reply to:
Ladies and Gentlemen: b
AutoText available in: AutoText available in:
CSF_70-42-006.dot (Template) v| | Normal.dot (global template) v
Close File Close File

Description
Here is a sample AutoText entry that indudes bold, *

Close

Figure 9. Copying AutoText From One Template to Another
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